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Among many Tehetan Buddhist
teachers, there has bmg been a
rradition that vegards the kimgdom
of Shambhala not as an external
place, but as the ground or root
of wakefulness and sanity thar
gxises as pogential withm cvery

humgm being.

Chiigram Trungpa, founder of
the Naropa Institute and author
of Shambhala: The Sacred
Pauth of the Warrior.

Introduction to
Heaven & Earth

The Legend of Shambhala

Tales of a fabulous ancient kingdom have long
echoed in the temples of Tibet and other Asian
countries. Countless penerations have heard the
legend of a prosperous, golden land called Shambhala
— a remarkable place bathed in peace, harmony, and
communal good will. The legend speaks of wise,
compassionare rulers poverning a populace of highly
developed people. From the tapestried halls of s
roval palace to the tiniest hamlers ar its furthest
borders, Shambhala is said to have been a model
soCiety.

How did such a land come to exist? The stories
tell us that Buddha himself handed down advanced
tantric teachings to the first ruler of Shambhala,
Dawa Sangpo. The benevolent king openly shared
these teachings with his peaple. Soon, all of
Shambhala began to study, meditare and tollow what
the tantra call “the path of the spiritual warrior.”

Many Tibetans believe that the kingdom of
Shambhala still exists, hidden deep in the pure,
uncharted valleys of the Himalayas, Other legends
suggest that the enlighrened society literally tran-
scended into a more celestial realm many centuries
ago. Indeed, true believers insist that the Rigden kings
of Shambhala continue to watch over human affairs,

and will one day return to show mankind the path.
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The [lhusions

Heaven & Earth — The Computer
Experience

Heaven & Earth is a compurer experience
inspired by the Shambhala legend. As you use the
program, you are invited to open your mind, to
approach the product as a strategic challenge, as a
relaxation tool, or as a vehicle of pure entertainment
— whatever your current frame of mind wants it to be.
Heaven & Earth does not have a specific path that
needs to be followed, nor does it define what is
SUCCESS.

Entertainment software falls into one of three
catepories: toys, puzzles or games. Toys are played in
a freeform manner; there 18 no scoring or time limir.
Puzzles provide visual challenges, requiring the
components to be manipulated in a specific way in
order to be solved. Games have a specific goal, but
players may successtully complete the game and have
different scores or results based on their particular
strategic approach.

Heaven & Earth transcends the three caregories,
bringing all three together with an animated toy
called the Pendulum, an vriginal straregy game called
the Card Game and a set of oprical puzzles called the
Hlusions. You have the option to focus on one, to
become an expert in two, or to master all three.

Heaven & Earth is also designed to be played

holistically, wirh all three components merged into

one entertainment experience in a spiritual journey

called the Pilgrimage.
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Requirements

Hardware

Monitor, mouse, keyboard, hard disk, floppy disk
drive and one of the following CPUs: Macintosh
Plus, Classic, Classic 11, SE, SE/30, LC, LCIL 1, Tlei,
ex, Lsi, 1k, Quadea 700 or Powerbook 170.

Heaven & Earth was tested on the above
machines, but most likely will work on other
machines like the 1%, Powerbook models 100, 140
and 145, and Quadra models 900 and 950.

Optional Equipment

Accelerator Boards

Adding an accelerator board 1o low-end machines
will improve the play of the program considerably.
If your system hardware has an accelerator board, you
may need to use a supplemental sound driver uriliry
to access the sound effects in the program. (Most
accelerator card manufacturers can supply vou with
soumd driver urilities o correct sound problems thar

may be caused by the acceleraror card.)

Radius Monitors

It you are installing Heaven & Earth on a system
thar uses a Radius monitor, or installing a program for-
mat that is smaller than your moniror (e installing a
12" version on a 13" monitor), be careful not to move
the program window around on the moniror as this
may cause the program to function incorrectly when

the cursor 15 used on the program screens.

System Requirements

Systems 6.0.5— 7.0.1 Note: The “Hide in Back-
ground” command found under Preferences in the File
Menu works with System 6.0.5or 6.0.7 and Multi-
Finder, but not with System 6.0.5 or 6.0.7 and Finder,




Memory Requirements
The program format determines rhe amount of
free RAM and Hard Disk space required:

Free Hard Disk Required
Formar Space Required Free RAM
Black & White 2370K 1000K
12" Color 4571K 2000k
13" Color 6348k 2350K

Note: Increasing the application size by an additional
S00K o 1000K of RAM will result in improved per-
formance of the program. To increase the application
size, seleet the applicarion when it is not active and
then choose Get Info from rhe File Menu. Change

the application size when the window appears.

Heaven & Earth Diskettes

The Heaven & Earth program comes on 6 double
sided/double density disks. If you do not have 6 disks,
please refer to Appendix B: Buena Vista Software
Customer Service, at the back of this handbook.

Installing
Heaven &
Earth

Heaven & Eurth comes with an install program
that guides you through the imstallation process. The
program is on the floppy disks in a compressed form
and must be decompressed by installarion on a hard
drive. The program is not playable from the floppy
disks. There are three program formats available:

13" color, 12" color and Black & White.

I. Insert Heaven & Earth Disk =1 into your floppy
drive. When the disk icon appears, a window will

open displaving three installation icons - one for each




Quick Install
If vou don't want to read
the til.!l:{t]l.,‘-._} ll1,:.[._=|||_.jt'i|._rI'|
SEEps:

Insert Thsk =1.

Double-click on the
appropriate installer.

Follow the on-screen
inscrucrions until
the installation is
complete.

of the three available formats. Double-click on the
installer appropriate w your computer. (There is also
a file called “H&E/part #6” which is an installation
control file. Do not open or tamper with this file because
it condld alter the mstallation mstructions and mterfere with

the mstallation process. )

2. When the Installation window appears; it will
display the formar tvpe you have chosen, the name
of the volume (hard drive) thar contains your system
tolder, the hard drive space necessary for the chosen
format and the amount of space currently available
on your hard drive. You can cancel the installation

process by clicking on the Cit option.

3. You can change the destination location by
selecting the “"Change Volume/Folder™ option.
Clicking on this button will bring up another window
displaying rhe folders available in the current volume.
To change the destination folder, click on rhe name
of the desired folder in the selector window. To
change the destination volume, select the “Drive”
burton to display the name of other hard drives in
vour system. (I no other hard drives are available,
the name of the disk currently in your floppy drive
will be displayed.) When you are satisfied with the
desrination for the installation of the Heaven &
Earth folder, click on *OK."” This will return you to

the Installation window.

4. Click on the “Install” button. The installation
program will now periodically prompt you to insert
the necessary disks to complete the installarion of

your chosen formar. A starus window will display the

progress of the installation. You can aborr the instal-
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lation ar any time by selecting “Cuit.” When all of
the necessary data for the chosen format has been
decompressed and installed on your hard drive, an

Installation Complete message will appear.

There will now be a folder called "Heaven & Earth”
in vour destination volume and folder. In this folder
will be the “Heaven & Earth” application icon and
an “H&E Resources” folder containing the decom-
pressed dara for the chosen format. This data is
necessary for the program to function correctly and
must be kept in the"H&E Resources” folder with the
“Heaven & Earth™ applicarion.

5. If you chose to abort the installation at any rime
during the process, there will be a Heaven & Earth
folder on your destination volume containing the
data installed prior to vour cancellation of the
process. This folder should be discarded (dragged o
the Trash icon) since the files may not have been

completely copied onto the hard drive.

Troubleshooting

If you encounter problems during installation,
refer to Appendix A: Troubleshooting Guide, at the
back of this handbook.

Ehang'ng
the Format

You can change the formar of the “Heaven &
Earth” installation by repeating the installation
process (steps | through 5 above) and selecting a
different installer format. However, since the data for
the three formars is different, you must discard the
entire Heaven & Earth folder prior to starting the

new installation.




8
Heaven &
Earth

1. To start the program, double-click on the Heaven
& Earth icon or select the Heaven & Earth icon and
choose Open from the File Menu.

2. You may be asked to enter a word that can be
found in this manual. The first capitalized word(s) in
the question indicates where in the manual you can
find the answer. Use the Table of Contents at the
beginning of this manual to determine the section
where the answer is located. Then go through that
secrion to find the answer. Type in the answer and
press the Retum key (it doesn’t marter if you use
upper or lower case text). If you answer the guestion

correctly, you enter the game.
Here's an example of how o locate a word:

CARD GAME/CELESTIAL PHENOMENA:

What armospheric phenomenon has a muleiplier of 4!

To answer this question, go to the Table of
Contents and look up “The Card Game-Celestial
Phenomena” section. Tum to thar page and go
through the section to find the answer. In this
example, the answer is RAINBOW listed on Page 39.

3. After the title screen appears, a “Welcome plaver”
window will appear with the most recent player's
name indicated and rhe following options: Players
and Continue. (The first time you open the program

you will be welcomed as “Traveler.”)

Players
Selecting Players will open a Player's Option
window listing the current player and the following
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Hﬁ‘_‘ﬁ'”'lhi Eanih Selecting New opens a window with the word
“Player” highlighted. Enter a new name and
choose Save to change to a new player. (The
program only displays names of 20 characrers or
less.) Select Continue to go to the Gareway

L

Open

Eandic Selecting Open brings up a list of the saved games

(if there are any). Double-click on a saved game
or select a saved game and choose Open to
change the current player. After you open a saved
game, you're returned to the Welcome window.

Select Continue to go to the Gateway screen.

Cancel
Selecting Cancel returns you to the Welcome

window,

The Gateway

The Gateway is your entry into Heaven & Earth,
It contains portals that take you to the different parrs
of the Progranm. T pass thn‘.-l_lf_f:]'l the ':.]:'I.I.'l:"l."r".l"f to the
Pendulum, Card Game or Hlusions, move the cursor
onto its Gateway icon and click the mouse button.
To embark on a Pilerimage, select the palace nestled

in rthe mountains near the op of the screen.




The Gateway

Pilgrimage

Pendubion

Card Crame

Maesioms

F it Clame

Hﬂw to Plﬂ? Heaven & Earth is composed of four parts: the

Heaven & Card Game, the Pendulum, the Hlusions, and the
Eﬂl‘th Pilgrimage. You can play any of these parts in any

order. You are not required to finish one part ro be

able to go on to another,

B The Pendulum is a toy. You control the swing of a

pendulum to “capture” positive vortices.

The Card Game is an original card game.
Reminiscent of gin rammy or mah-jongg, your goal

is to create tricks and ger the highest score you can.
The lusions are a collection of optical brainteasers.

The Fjlg‘ritnugr is a combinarion of all three. It also

contains inspirational messages for your enjoyment.

C(}ntrﬂning Using the Mouse
thE Gﬂ.me You use the mouse w play Heaven & Earth

although in some of the Mlusions the keyboard is also

available. For information on keyboard controls, refer




to the Help section within rhe individual Hlusions or
the Hlusions section of this manual.

You can activate options through the simple
point-and-click method. Just use the mouse to posi-
tion the cursor over the option you want, and then
click the mouse button to select that option. You can
manipulate objecrs through the click-and-drag
merhod. Position your mouse cursor over the object,
and then press and hold down the mouse button.
Then “drag” the object to its new position and drop

it by releasing the mouse burton.

Keyboard Command Keys ()

Heaven & Earth contains command keys thar ler
vou quickly execute a command. These command
keys are indicared in the pull-down menus of cach
part of the program.

The Menu Bar appears when you click rhe mouse
button at the top of the screen. When you select a
menu option, a full menu appears beneath it
Ghosted oprions (options which are graved) are
currently unavailable. Some Menu options have
submenus indicated by an arrow () to the right of
that option. Drag the cursor over the arrow while
holding down the mouse button 1o reveal the
submenu, When the desired option is highlighted,

release the mouse button to select it.

The Gateway Menu
To access the Gareway menu bar, move the cur-
sor to the top of the screen and hold down the mouse

button. The following menus appear: @&, File and Edir.

# (Apple Menu)
Selecting the Apple Menu gives you the follow-




ing oprions:

About Heaven & Earth
Displays credit information abour Heaven & Earth.

(Desk Accessories)
Any desk accessories you have loaded should be

accessible within the program.

File
Selecting the File Menu gives you the following
oprions. Activated options (options that are turned

on) have a checkmark (¢ ) next to them.

Gateway &£ G
Takes you to the Gateway screen Selecting this
while the Gateway screen is displayed will have

no effect.

Plavers
Opens a window displaying the name of the cur-
rent player and options to name a new player or

apen A .“-'-:’I"l-'li.‘d. ETAITA.

Preferences

Opens a window with options to hide the game and

turn oft cycling when a desk accessory is chosen
from the Apple menu. (Black and white formats
only offer the option to hide the game.} Oprions in
the Preferences window that are nurned on have an

ik

x" in the box.

Quit FEQ

{Juits the program and returns you to the deskrop.

Edit
There are no Edir options available on the

Gareway screen so all options will be ghosted.




Synchromizing mind and body is
not a concept or a random
technigue someone thought up
for self-tmprovement. Rather, it
is a basic principle of how to be
a human being and how to use

YOUT sense perceptions.

From Shambhala: The Sacred
Path of the Warrior




The Pendulum is an animated toy thar simulates
an actual pendulum. A pointed weight is suspended
at the end of a “string” over a concave, bowl-shaped
playing field. This playing field is strewn with one or
more pravity wells — each called an energy vortex —
which exert a pravitational pull on the pendulum as
it swings over or near them. Your goal in the
Pendulum is to control the pendulum’s swing to
capture positive vortices.

Each new configuration of vortices on the playing
field is called a scenario. There are six different sce-
narios in each of the Pendulum’s four levels of Ocean,

Desert, Mountain and Sky.

Levels

There are four levels of difficulty. From easiest to
most difficult they are Ocean, Desert, Mountain and
Sky. Early scenarios in a level may have only one
positive vortex and no negative vortices ar all. Later
scenarios, however, will feature many positive and
negative vortices at the beginning and additional
vortices may appear as others are captured.

On any given level, you must capture all positive
vortices before that level is successfully completed.
Visual and sound cues inform you when a specific

VOItex OF sCenario has been mas LL‘FL_‘LL

Positive Vortices

One type of energy vortex is the positive vortex.
You want o control the pendulum so that the point
of the pendulum comes to rest directly over a positive
vortex, thus capruring that vortex and making it
disappear. This is called “mastering a vortex” and is

WORUT l-_!l.f'-.’l.t in l..‘il.L'I:I SCEMAric.

Positive vorrices differ in appearance from level




In this example, the pendubum
swinging lefe oo vight. To merease

swimg speed, moll the mowse 10 the

right. To dervease spwed, mill the
merese (o the left.

to level. For example, in the Ocean level they look
like blue pearls, while in the Sky level they are
multi-colored starbursts. In some scenarios they are
invisible. (In black and white versions, vortices take

different shapes.)

Negative Vortices

The more challenging scenarios have negarive
vortices in addition to the posirive ones. Like a posi-
Hive vortex, a negative vortex exerts a gravitational
pull on the pendulum. The important difference is
that you do not want your pendulum to be captured
by a negative vortex. If this happens, your pendulum
weight is “thrown o the heavens” — wildly tossed
abour — and you must start the scenario over again
(i.e., it you've til[‘rlLIl'L‘\_{ two of the three positive vor-
tices and then you hit a negative vortex, the posirive
vortices will reappear and you will have o start the
mastering process for all three vortices all over again. )

Negative vortices vary slightly in appearance from

]1_"'-.'!._'“]_ i lg‘\'l,_"]_. ll'l, Lo NS .‘i-l,:L"IiIII!'i.I. ] '|.h|.."!|-' e i'l\‘iﬁi]ﬂl’t‘-

How to Play the Pendulum

1. Start the game.

Select the Pendulum icon from the Gateway
screen. The game starts with the bowl and the vortex
(or vortices) on the screen. Clicking the mouse but-

ron will start the pendulum swinging.

2. Control the pendulum.
The Pendulum is played from a perspective that
looks down from approximately a 60-degree angle on

the bowl of the playing ficld. Use your mouse to

"-'.'J'n'llglﬂl;lﬂll':ll. . ] .‘.l..'w
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affect the movement of the pendulum.

Muost compurer action games demand a high
degree of hand-eye coordination and lightning-fast
reflexes. This is not how the Pendulum was designed
tor be played. The pendulum’s swing is controlled —
though “influenced” would be a better word = by the
movement of the mouse,

Your can envision controlling the }'u:nr.luh.|m in this
way: Imagine that the pendulum is swinging freely
and that vou control it i:n,' directing a breeze on it, or
by gently “blowing” on it. Simply move the mouse in
the direction that you want the breeze to “hlow.”

To make the pendulum swing faster and higher,
blow in the direction it is moving; in effect, you give
the pendulum a tail wind. If you want to slow it down
or shorten the arc, blow in the opposite direction of
the pendulum’s movement.

3. Master the scenario.

Capture all the positive vortices in the scenario
to master that scenario. Every time you capture a
positive or negative vortex, you will hear a sound
(as long as the Sounds option is on). The sounds for
positive and negative vortices are different. When
vou've mastered a scenario, the pendulum cycles.
Cycling is an effect in which a variety of colors or
shades are quickly flashed, giving the appearance of

motion. { Turning off Ambient Animation from the

menu does not affect pendulum cyeling when you

master a scenario; it only atfects the vortices. )
There is no scoring in the Pendulum but mas-
rered scenarios will be indicared by a diamond (@)

next to the name of the scenario in the menu bar.
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Warning: Be caretul
when using the com-
mand keys and menu
bar oprions. You may
not get a chance to
cancel your selection.

It vou are in the middle
o @ sCcenario ﬂl'll.'l CXIL
that scenario, you will
torfeit all progress made
in that scenario,

l." |u' .J |I||I'..

|||

il il

4. Select a different Pendulum.

You can select a different scenario at any time.
Please note that scenarios cannot be saved. If you've
mastered a positive vortex in a scenario that has more
than one positive vortex and you exie the scenario,
you will start over from the beginning when you
return to that scenario.

New scenarios are available from the menu bar.
To selecr a new scenario, go to the Pendulum menu.
Submenus under Ocean, Desert, Mountain and Sky
list the six individual scenarios for thar level. The
current scenario will be indicated by a checkmark
(¢ ) next to it Select a new scenario and it will
appear. You can also use the Command keys to move

around within the game.

Command Keys
The following command keys can be used at any

time during the Pendulum game:

a8 N Starts the next scenario.
3£ P
# R
# G
3 Q

Starrs the previous scenario.

Restarts the current scenario.

Retums vou to the Gateway screen.
Ouits the program and returns you to the

deskrop.

Clicking the mouse button pauses the game and

returms your l'li.!l.'l'lzl-i:'l.l TTRLALISE CLITSCH.

Pendulum Menu Bar

To access the Menu Bar click the mouse button
at the top of the screen. The following menus appear:

&, File, Edir, Options and Pendulum.




& (Apple Menu)
Selecting the Apple Menu gives you the following
OPLIOns:

About Heaven & Earth
Displays credit information about Heaven & Earth.

(Desk Accessories)
Any desk accessories you have loaded should be
accessible within the program.

File

Selecting the File Menu gives vou the tollowing
Opions:

Gateway 8 G

Exits the Pendulum and returms you to the

Gateway.

Players
Ohpens a window displaying the name of the

current plaver and options to name a new player

OT CPTY A .‘iH"-'L"IJ EALTRC .

Preferences

Opens a window wirh oprions to hide the game
and turn off cycling when a desktop accessory is
chosen from the Apple menu. (Black and white
formats only offer the option to hide the game. )
Options in the Preterences window thar are rurned

on have an *“x" in the box.

Quit 3 Q

Quits the program and returns you to the deskrop.

Edit
There are no Edir oprions available in the

Pendulum so all options will be ghosted.




Options

Selecting the Options Menu gives you the follow-

ing options. Activated options (options that are

rurned on) have a checkmark (¢} next to them.

Sounds

Lets vou turn the sound effects on or off.

Ambient Animation

Lets you tum the cycling of vortices on or off.
Whether this option is on or off, the pendulum
always cycles when you master a scenario. (This

option is not available in black and white version. )

Transparent Pendulum

Activating this option rurns the pendulum into a
transparent, “wire-frame” object. {Recommended
for faster movement of the pendulum on slow

machines. )

Activated oprions (options thar are rurmned on)

have a checkmark {#) nexr to them.

Pendulum
Selecting the Pendulum Menu gives you the fol-

lowing options:

Ocean, Desert, Mountain and Sky

These are the four levels of the Pendulum. Each
have submenus listing the six scenarios in that
level, The current scenario will have a checkmark
(v) next to it. Mastered scenarios will have a
diamond (#) nexr to them.

You can select a scenario from any of the sub-
menus by holding down the mouse button until

the desired scenario is highlighted and then




releasing the mouse button. The selected scenario

will then appear on the screen.

Start Next 38N
Ends the current scenario and starts the next

SCCTIATION

Restart #ER

Bustarts l'i'lf" CUITENE sCenaro,

Start Previous 48P

Ends the current scenario and starts the previous

SCenario.

Help
Displays information on how the Pendulum game

works and explains your goal.

Playing Hints

You may discover that it is difficult to have a very

immediate and dramatic effect on the pendulum’s

swing. Here are tips for berrer control:

B The Pendulum requires some patience to master,
Carefully comsider the swing’s current
characteristics, and then calculate what subtle
changes you can make that will cumulatively

change the direction and power of the swing.

You will find that conrrol is casier if your move-

ments are kept subtle and precise.




Healing our society goes hand
m hand with healing owr
personal, elemental
comnection with the
phenomenal world.

Experiencing the sacred world

is recognizing the existence of
its vast and primordial

wisdom. ..

From Shambhala: The Sacred
Puth of the Warrior
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The Card Game in Heaven & Earth is an original
computer card game. It is inspired by the traditional
Japanese flower card game “Hanatuda,” a popular
tamily pastime of that country. Basically a rummy-
type game like mah-jonge or gin rammy, it uses
picture cards composed of painted landscapes and
borders. Each card fearures elements of the natural

world — shapes, seasons and celestial phenomena.

How to Play The Card Game

The object of the Card Game is to choose cands
from the current deal, and then arrange them into
tricks thar produce the highest score. It requires

strategy, skill and a little bir of luck.

1. Start the Game.

Select the Card Game icon from the Gareway
screen. When the Cand Game screen appears, the
Playing Board will be empty except for a deck of cards
face down, an Info Bar ar the bortom of the screen

and a Gateway icon in the lower right comer.

2. Deal the cards.

Heaven & Earth is played in four rounds. In the
first round, cards are dealr off the 48-card deck four ac
a time. Click on the card deck to deal the first four
cards. They automartically flip face up in the
Selecrion Area on the upper right side of the screen.

When you move the cursor over individual cards
or tricks, information relating to them is shown in
the Informarion Bar ar the bottom of the screen.

(If you don't see this information and want 1o, select
the Info Bar oprion under the Options Menu.) Other

information — the Round vou are on, the current

i L IrI II.
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Important: Make sure
cards do not touch each
other ar all it chey do
not belong in the same
trick. Even the tiniest
overlap will cause the
program fo assume thal
they arc part of the
samie trick.

Al

Round Score and the current Game Score — always
appear in the Information Bar.

3. Choose a card.

Click on one of the four cards to select it for your
hand. The card will automatically move onto the
Playing Ficld. You can also click and drag the card
manually onto the Playing Field.

Afrer you choose a card from the deal, the other
three dealt cards automarically move into a holding
pile in the Discard Area at the lower right side of the

SCPeET.

4. Fill vour hand.

Repear steps 2 and 3 until the 48-card deck is
exhausted — 12 deals in all. You should now have 12
cards on the Playing Field. This is your first round

hi:ll'll-.l-

5. Create tricks.
Arrange your hand into the highest possible
scoring tricks. (See “Creating Tricks” later in this

section for complete details on tricks.) Make a trick

by placing cards on top of each other. To do this,

click on a card and drag it until you've positioned it
s0 that it overlaps another card. Then release the
mouse button.

The Informarion Bar at the bottom of the screen
shows you everything you need to know about indi-
vidual cards and tricks. (If you don’t see this informa-
tion and want to, make sure the Info Bar option
under the Options Menu is selecred.) If you place
the cursor on a single card, the Information Bar gives
details on that card. If vou place the cursor on a mrick

{two or more overlapping cards), the Information Bar




tells you what type of trick it is and its point value.

6. Undo tricks if necessary.

To undo a trick, simply reverse the process of
creating a trick. Drag the top card off of the card it is
touching. Just because you've created a trick does not
mean you are bound to it. Tricks are not final unnil
the end of the round.

Before you commit to a hand, you might want to
play around with the rricks. Take some apart and
rearrange them into new tricks to see if you can ger
even more points. You can always return the cards to
their previous trick formation if you're not successful

in getting more points.

7. Complete the first round.

When you are satisfied with your first hand, move
the cursor to the Discard Pile and click the mouse
button. The tricks are tallied and all the cards trom
that hand are cleared from the Playing Field. This

completes the first round.

8. Complete the second round.

For the second hand, repeat steps 2 through 7
with the remaining 36-card deck (those cards discard-
ed in the first round). In the second round, the cards
are dealt off the deck three at a time. Choose one
card from each 3-card deal until the deck is exhausted
- again, 12 deals in all — then amange your second
hand inro tricks. Click on the Discard Pile ro rally
the tricks and clear the Playing Field.

9, Complete the third round.
The third round is played with the remaining 24-

card deck. Repeart steps 2 through 7, choosing one of
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the rwo cards in each of the 12 deals. Click on the
Discard Pile o rally tricks and clear the Playing Field.

10. Complete the fourth and final round.

This time when vou click on the deck for the first
deal, the remaining 12 cards will automatically be
dealt directly ro the Playing Field. This constitutes
your fourth and final hand.

Click on the Discard Pile area when you're done
creating rricks. The pame is completed after the
fourth hand is tallied and the rotal score for all hands
is then tallied.

11. Enter high score.

If you have a high score, a window will appear,

e
e prompting vou to enter your name. The scores from

the first twelve games are automatically recorded as

high scores. After you enter your name and press

Return (or click on “Done™), you will see a list of the

top scorers. When the High Score screen is full, you
will only be prumrllt:ui to add your name it your score
exceeds the lowest score listed.

You can clear the High Score screen by selecting
Clear on the High Score screen. You will be asked to

confirm this action before the program will erase all

the scores from the screen.

12. Leave the Card Game.

You can leave the Card Game at any time by
sclecting Gateway under the File Menu, typing 368G,
or clicking on the Gateway icon in the lower right
cormer of the screen. You will be asked o confirm
YO selection {in case Yo want o save the g;llm::I

before vou go to the Gateway.




Warning: Choosing
"Lhait” from the File
Menu or pressing 3§ O
will rake you directly to
the deskrop withour
"\::!L.i.l-"‘_" Kor CuTTETL

| mame.

Command Kevs
The tollowing command keys can be used ar any

rime during the Card Game:

3 G Returns you to the Gareway.

d6 Q0  Returns you to the deskrop.

487  Undoes last card selection,

g6 N Ends current game and starts a new game.
# R Restarts the current game.

8 D Deals the next set of cards,

38 1 Displays informarion about a selected card.

Card Game Menu Bar

To access the Card Game menu bar, move the
cursor to the top of the screen and hold down the
mouse button. The following menus appear: @, File,

Edit, Options and Pendulum.

® (Apple Menu)

Selecting the Apple Menu gives you the follow-

I Options:

About Heaven & Earth

Displays credir information about Heaven & Earth,
(Desk Accessories)

Any desk accessories you have loaded should be

accessible within the program.

File

Selecring the File Menu gives you the following
OPLIOns:

Gateway 3G

Exits the Card Game and returns you to the

Giareway.




Plavers
Dpens a window displaying the name of the
current player and options ro name a new player

or open a saved game.

Preferences

Opens a window with options to hide the game
and rurmn off cycling when a deskrop accessory is
chosen from the Apple menu. (Black and white
formats only offer the option to hide the game.)
Options in the Preferences window that are

rurned on have an “x" in the box.

Quit & 0

Quits the program and returms you to the deskrop,

Edit
Selecring Edir reveals a list of options, most, if not
all, of which will be ghosted. The only Edit option

available in the Card Game is:

Undo a8 7

Lets you undo the last card selection and return it
to the Selection Arca (which restores the last
deal). This option is available only if there is a
card on the Playing Field.

Options

Selecting the Options Menu gives you the

following options. Activated options (options thar

are turned on) have a checkmark («) next to them.

Sounds

Lets Yo T lI'll..‘ .‘i-I'-.HI!'I.d i..‘H'-L"I..'-lb O O LI'H.-

Ambient Animation

Lets vou tum the card border animation on or off,

e



( This oprion not available in black and whire

VEeTsions. )

Phenomena Animation

Lets vou turn the phenomena animations on or off.

Fast Deal
When this option is selected the cards will move

taster across the screen.

Info Bar
When this option is turned off, no information
about individual cards or tricks will appear in the

Informarion Bar at the borrom of the screen.

Warnings
When this option is turned off, no confirmation
windows will appear when you select Menu

aptions that will end the current game.

Choose Board
Has a submenu listing six possible playing boards

and card backs. (In black and white versions, there

are two possible playing boards available.) This

function is available at all times, even during a
game. The program remembers which board you
used Last and auromatically brings it up the next
rime vou play the Card Game. The board you use
has no h-uuriup, on the pln'l,.'ing of the game or the

FAITIC S SCOTE.

Card Game
Selecting the Card Game Menu gives you the

tollowing options:

New Game 3EN

EIIL'L‘* ll‘lt': current game HI'l'd STATTS A e S,
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End Game
Ends the current game.

Restart 3£ R
Ends the current game and then starts the same

game over (using the same inirial shuftle and

assigning the initial phenomena to the same cards).

Load Game
Lovads a saved game. Selecting this option brings
up a window listing the saved games. Double-

click on the desired game and the program will
load thar pame.

Save Game

"y
SAVEs LI!IL‘ CUTTEND @A S0 Vo Can pesume I.".L'u:l'g'

at any time. Selecting this option brings up a
window with a highlighted name box. Type in

the name you wanrt to save the game under and

choose Save or press Return, If you have already

saviedd a game under the same name, a confirma-

tion window will appear asking if you wish to
replace the existing saved game with rhe new one.

Deal Cards #ED

Deals a new ser of cards to the Selection Area.
When all the cards in 2 Round have been dealr,
this option will be ghosted.

Next Round
Removes all cards from the Playing Field and sets

the deck for the next round.

Get Card Info 48 1

Brings up a window with complete information
about a selected card. To use this option, click on
any card o select it (selecred cards are identitied
by a border around the outside edges) and then
select Gier Card Info.

'|,|.'|I-I|| T {i
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Mountain

Show High Scores
Brings up the High Score screen.

Help
Displays information about the Card Game and

IS SCOFNE.

The Suits and Landscapes

The Card Game deck consists of 48 cards divided
into 12 suits of four cards each — almost the exact
inverse of standard western plaving card decks which
have four suits of 13 cards each. Each suit symbolizes
one of the 12 months of the vear and the four cards
per suit each have a different value portrayed by land-
scape images. From lowest to highest in value, these
landscape images are: Ocean, Desert, Mountain and
Sky.

The 12 suits {or months) are divided into seasons
(winter, spring, summer and autumn) and elements
(earth, air, fire and warer). No two months have the
same combination of season and element: January is
a winter month with an earth sign, while December
is a winter month with a fire sign. August shares
December's fire sign but is a summer rather than

winter I'[l'LT]'III'I-




Seasons
A card’s season is indicared by the top border of

the playing card:
Spring
Summer
Autumn

Winter

The months in each season are:

Spring March, April, May

Summer June, July, August

Autumn September, October, November
Winter December, January, February

Elements
A card’s element is indicared by the left border of

the playing card:

””'IIII | :ll. ] i I'I-JIW
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The months in each element are:

Earth = May, September, January
Air June, October, February
Fire April, August, December
Water July, November, March

The unique combinations for each of the 12 suirs

are shown in the following chart:

Sane ¢ | OEED | NS | SEE
I-EI'I'-th Winder Spring

May

July  November

The following are some sample cards with descrip-

tions of their suits and values:

The tirst card, with a Winter border on the top and
an Air border on the left, represents the suit of
February. [t also has the highest landscape value of Sky.

The second card, with an Autumn border on the
top and an Earth border on the left, represents the
suit of Seprember. It has a Mountain landscape - the

second highest in value.

- :#l#p :"‘m ]
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Excirmplee oof four May cards

Excmmple of three Oloegm cords
with e swiis

rnattching element of Fe (left
bordar ) aned mixed bmvdscapes

The third card, with a Spring border on top and a
Fire border on the left, represents the suit of April. Its
Diesert landscape is the third highest in value,

The fourth card, with a Summer border on top
and a Water border on the lett, represents the suit of

July. It has the lowest landscape value of Ocean.

Creating Tricks

Your primary objective is to creare rricks. A mrick
is two or more cards that are assigned a specihic point
value when grouped ogether. There are dozens of
possible tricks, and all are based on relationships
inspired by months, seasons, elements, astronomy and
meteorology.

At the simplest level, vou can create tricks solely
by matching borders and/or landscape images, without
any understanding of the significance of rhe borders or
landscapes represented. While the Card Game can be
easily learned and quickly plaved, only by becoming
very familiar with the suits will you be able to make
rhe associarions between the seasons, elements and

mdividual months that result in the highest scores.

All the possible types of tricks are listed below:

4 of a Kind

A 4 of a Kind trick is created by grouping the four
different landscape cards of the same month. Cards
that have the same season (top border) AND same

element (left border) are the same month.

3 of a Kind

A 3 of a Kind erick is created by grouping three
cards with the same season (top border) OR the same
element (left border) OR the same landscape image.




Example of ofgweste months
(M + November)

2 of a Kind
A 2 of a Kind trick is created by grouping two dif-
ferent landscape cards of the same month; matching

seasons (top border) AND elements (left border).

Opposite Month

An Opposite Month trick is created by pairing
two cards that represent rhe equinox, the solstice or
the different rypes of moons:

January + July Snow + Heat Moons

February + August = Hungry + Hunring Moons

March + September Equinox

April + Ocrober Buds Appearing + Leaves
Falling Moons

May + November Planting + Harvest Moons

June + December Solstice

Trick Scores

Here are some details on scoring:

Each trick has a score assigned to ir, as shown on
page 33.

Scores can be increased or decreased when celes-

tial phenomena are present when the trick is

formed. Celestial phenomena are explained in

the “Celestial Phenomena” section.

Bonus points are eamed if all 12 cards in a hand

are used in rricks.

The landscape on cach card has a value. Score
values are ranked as follows (from lowest to
highest): Mixed landscapes, Ocean, Desert,
Mountain, and Sky. For instance, a 3 of a Kind




trick consisting of one Ocean landscape and two
Desert landscapes with marching seasons (or
clements), constitures a Mixed Landscape which
is worth less than a 3 of a Kind created from three
Ocean landscapes with matching seasons (or

clements).

Celestial phenomena alone cannor be used to
creare a rrick. Even if two or more cards have the
same type of celestial phenomena (i.e. Full Moon
and Crescent Moon), they do not constitute a
trick. Tricks are based only on the combinations
of the top borders, left borders and landscapes.

The point values for each type of trick are as

fiol lovwrs:

4 of a Kind (4 cards of the same month) 1000

3 Landscapes (3 cards with matching landscapes):
Sky 300
Mounrain 250
Desernt 200
Ocean 150

3 of a Kind (3 cards with one matching border):
Sky 600
Mountain 500
Desert 400
Ocean 300
Mixed 150

2 of a Kind (2 cards of the same month) 100




Ocean with  Mountain with
Creseent Moon  Apex Sun

Sky with
Lightning Tornado

Opposite Monrh (2 cards of opposing months);
Sky 1000
Mountain 800
| Jesert 600
Ocean 400
Mixed 200

Bonus Points for Completed Hands
You can eam additional poinrs by using all the
cards in a hand. This means that every card in a hand

was used in a valid mck.

Ist time all cards used in a hand 500
2rud time all cards used in a hand 1000
3rd time all cards used in a hand 1500
4rh rime all cards used in a hand 3000

Celestial Phenomena

While every trick in the Card Game has a specific
value, that value can increase or decrease when ran-
domly generared celestial phenomena occur in one or
more of the cards in that wick. Celestial phenomena
are animarions randomly assigned to cards in each
hand and depict events such as rain, sunsets, light-

ning, rainbows, shooting stars, full or new moons, etc.

Celestial Phenomenas

B Occur randomly; a particular phenomenon may

not appear at all in a game.

B Have a multiplier value which can be positive or

negarive.

B Always appear in the card’s landscape (the center
of the card).




B In many cases will animate when the card is
selected (when the Phenomena Animarion
option under the Oprions Menu is on).

Are indicated in the Information Bar after the
month (when the Info Bar Option under the

Options Menu is on).

With the presence of one or more celestial phe-
nomena, a trick of low value can become tar grearer
in value, and a high value mrick can become one of
extraordinary value. Occasionally, a trick can
decrease in value when a celestial phenomenon with

a negative multiplier is used.

Frequency of Appearance

Not all celestial phenomena are distribured in the
first round of a game; phenomena appear in all four
rounds. Thus, a discarded card that did not have a
phenomena in the first round could acquire a phe-
nomenon in a subsequent round,

Omee a celestial phenomenon has been assigned
ro a card, however, it remains with that card tor the

entire game.

Phenomena and Their Values
There are 22 different celestial phenomena that

can appear during each game. When a card with a

]I'I]"IL‘['II.'II'['IL"[]I.EII'I hecomes part of a lIiL’]i, LIlL' score for

that trick increases or decreases by the value of the
multiplier associated with that phenomenon.

For example, it a 3 of a Kind trick consisting of 3
Sky landscapes with mixed borders contains a card
with the phenomenon Lightming, the trick’s value of
00 is multiplied by 2 (the muluplier value for
Lightning) for a total of 600 points. See the table




below for a listing of Phenomena Muluplier Values.

If there is more than one phenomena in a trick,
the multipliers are added together o arrive ar the
tinal multiplier.

For instance, if a celestial phenomenon with a
multiplier value of 2 and a celestial phenomenon
with a multiplier value of 3 appear in the same rrick,
the hasic value of the trick will be multiplied by 5.

Phenomenon Multiplier
Moons

Crescent Moon

Halo Moon

MNew Moon

Full Moon

Suns
Apex Sun
Rising Sun
Setting Sun

Sun Combinations
Any 2 Suns
3 Suns

Eclipses
Lunar Eclipse
Solar Eclipse
Stars
Betelgeux
Double Star
Evening Star
MNorth Star
Shooting Star

bl et Pt b P Pl

Supernova
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Atmospheric
Earth Shine

Aurora Borealis

Rainbow

Weather
Tornado
Rain
Snow

Lightning

Weather Combinations
Snow & Lightning
Tomado & Snow
Ram & Snow
Rain & Lightning
Rain & Tornado
Tornado & Lightning
Rain, Tomado & Lightning

Playing Hints

The Card Game is easy to play burt challenging to

fully master. It will rake patience and skill to reach
the higher scoring levels (30,000 to 50,000 points) in

Al GTATTC.

B Use the Information Bar along the bottom of the

screen to learmn about specific cards and rricks.

B When you begin, concentrate on the hasic tricks
where you are marching either one or both boe-
ders andfor landscapes. As you become more
familiar with the game, leam the values of each of
the tricks so you can make the best possible

choice between two desirable cards.,




B [on't be in a hurry to play phenomena-bearing
cards. If you wait until the later rounds, there isa
greater chance of combining phenomena for

higher value rricks.

Become familiar with the months that the cards
represent and how they relate w cach other.
While the Opposite Month tricks are harder to
make, they can be worth more points.

Although it may be tempting 1o leave celestial

phenomena with negative values out of a rick,

the honus you get from using all the cards in a

hand may outweigh the value of the negative trick.




bl

The process of freeing yourself
from arrogance and cutting off
vour habitual tendencies is a
very drastic measwre, but it is
necessary. Once we
overcome habitual patterns,
the vividness of the drala
principle, or magic,
will descend, and we
will begin to be individual

masters of our world.

From Shambhala: The Sacred
Path of the Warrior

b
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Heaven & Earth Galeway

e Ciame

The Illusions portion of Heaven & Earth chal-
lenges your ability to imagine spatial relationships
hetween two- and three-dimensional objecrs. [t con-
sists of hundreds of visual puzzles, optical illusions and
graphic brainteasers.

There are twelve types of [lusions. Each type has
four different levels — Ocean, Desert, Mounrain and
Sky — and each level contains 12 different scenarios
for a grand total of 376 different scenarios 1o master.

Each lusion exercises a basic spatial perception
skill. For instance, certain scenarios in the ldentity
Maze have two cursors thar move symmetrically. In
some of these scenarios, moving one cursor up and to
the left moves the other cursor down and to the
right! When either cursor runs into a wall, both stop.
To master the maze, you must continually think

about two things at once.

The Musion Gateway
Clicking on the Illusions icon on the Gareway
screen brings you to the Hlusions Gareway. This

screen is your access to the 12 rypes of [llusion

puzzles. The names of each rype are displayed in the

center of the screen.
An Exit icon in the lower left comer of the

screen allows you to exit the program and return to
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the desktop.
The Gateway icon in the lower right corner of
the screen returns you to the main Gateway screen.

How to Play the lllusions

1. Choose an llusion.
Choose the rype of lusion vou want to play by
placing your cursor over its name on the Hlusion

Gareway screen and clicking the mouse button.

2. Start with this scenario, or choose another.

When you select a type of Hlusion, the first sce-
nario of the first level will appear. The screen displays
a puzzle in the center, an informarion bar and four
icons at the bottom.

The informarion bar below the puzzle displays the
Iusion type, the current level and scenario name. A
mastered scenario will have a diamond (@) displayed

next o is name.,

3. Master the scenario.

The scenarios in the different types of Hlusions
have different goals. For example, in Cursor Warping
vour goal is to deactivate targets in a certain order,
while in Figure Ground your goal is to move blocks so
they march a goal configuration. Derails on goals for
cach Musion are outlined in “The Twelve Hllusions”
section of this manual and within the Help option
found in the menu bar of each Hlusion.

4. Change the scenario.

To change o a different scenario, select the
Nlusions Menu and then select a new scenario from
the submenus under Ocean, Desert, Mountain and
Sky. The current scenario will have a checkmark (+)
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the middle of solving 3
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next to it. Mastered scenarios will have a diamond
(@) next to them.

You can press 6 P to go to the Previous scenario
or press ab N to go to the Next scenario. You can
also click on the Start Previous and Start Next icons

at the bottom of the screen.

3. Change the [llusion type.

To switch to a new type of Hlusion, select the

Musions Gareway icon in the lower right of the screen
or the HHlusion Gareway option under the lusion
menu. [his returns you to the Hlusion Gareway

b L 'l-"r'lli.'l'L" WL el :\L‘IL"L'L Hl'l.'i.J"LII“.‘]' mype I-'II. ].I.].lei'i.111-

6. Exiting the Nusions

To exit the Hlusions and retum to the main
Gateway, select the Gateway option under the File
Menu or press 38 G.

To exit the Hlusions and retumn to the deskrop,

select (uit under the File Menu or press 38 ().

lllusions lcons
The tour icons at the bottom of the screen per-

form the following functions:

- Start Previous
Takes you o the previous scenario.

Restart
Restarrs the current scenario.

Start Next

THLLL'.\ Vo fo 1hl..‘ NEXT SCenario.

Hlusion Gateway
Returns you to the Hlusion Gateway

soreen,
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Command Keys
The following command keys can be used within

the lusions:

38 G Returns you to the main Gareway screen.

a8 0 Retumns you to the desktop.

3 7 Undoes last move {not available in some
Husions).

38 N Takes you to the next scenario.

3£ R Restarts the current scenario.

FE P Takes you to the previous scenario.

Hlusions Menu Bar
Clicking at the top of the screen displays the

menu bar with the following options:

% (Apple Menu)
Selecting the Apple Menu gives you the following

options:

About Heaven & Earth

Displays credit information abour Heaven & Earth.

(Desk Accessories)
Any desktop accessories you have loaded should
be accessible within the program.

File

Selecting the File Menu gives you the following
oprions:

Gateway 3 G

Exits the Hllusions and returns you to the

Cateway.

Plavers
Opens a window displaying the name of the cur-

It
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rent player and options to name a new player or

Open d SH\"E.‘L{ g,

Preterences

Opens a window with options to hide the game
and turn off cycling when a desktop accessory is
chosen from the Apple menu. (Black and whire
formats only ofter the option to hide the game.)
Okptions in the Preferences window thar are

turned on have an “x™ in the box.

Quit 3JEOQ

Quits the program and rerurns you to the deskrop.

Edit
Selecting Edit reveals a list of oprions, most, it
not all, of which will be ghosted. The only Edin

option available in the Nlusions is:

Undo i
Lets you undo the last move. This option is avail-

able in only some of the Hlusions.

Options

Selecting the Options Menu gives you the follow-

ing options. Activated options (options thar are
turned on) have a checkmark (¢') nexrt to them.

Sounds

Lets you turn the sound effects on or off.

Ambient Animation
Lets you turn the puzzle animarions on or off.
(This option not available in black and whire

Version. )

Keys
Selecting Keys brings up a window which allows




vou to assign keyboard keys to certain move-
ments. You can select the keys you wish to use by

highlighting the current selection and then

pressing 4 key. The new key designation will

appear within the box.

Note: This option is only usable in some of the
Hlusions and not all keys on the keyboard are

assigmable.

Choose Background

Has a submenu listing three possible backgrounds.
(In black and white versions, there are two
!,‘u.‘:l:-u-',ﬂ‘l]q: hiuk;_:m_tuudb m-;ulnlwle.] This function is
available at all times. The program remembers
which background you used last and automatical-
ly brings it up the next time you play the
Mlusions. The background has no bearing on the
playing of the game.

Hlusion
Selecting the Hlusion Menu gives vou the tollow-

ing opticons:

Ocean, Desert, Mountain and Sky

These are the four levels in the Hlusions. Each
have submenus listing the twelve scenarios in
that level. The current scenario will have a
checkmark (v) next to it. Mastered scenanos will

have a diamond ( #)next to them.

You can select a scenario from any of the sub-
menus by holding down the mouse burton until
the scenario you want is highlighted and then
releasing the mouse burton. The selecred scenario

will then appear on the screen.




Start Next BN
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SCEnario.

Restart at R

Restarts the current scenario.

Start Previous 3P

Ends the current scenario and starts the previous
SCEMArio.

Help

Displays information on how the individual types

of Hlusions work and explaing your goal.

Musion Gateway

Returns vou o the Hlusion Gateway screen.
) ¥

General Guidelines

The scenarios tend to get more complex as you
progress within a level. In each level, the first one
or two scenarios exist to illustrare the rules that
apply in that level and are easy to master. The
last few scenarios within a level are often the most

difficult to master.

Don't get too hung up on the rules! You may find

that you do better if you just jump right in and ler

yourself intuit a solution. There is no penalty for
failure, so experiment and ger a feel for each

level.

Every scenario takes place on a single screen.
Some scenarios include a wrap-around fearure,

which is indicared by an additional border around
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the puzzle. In these Hlusions, the cursor(s) can
move through that border and re-enter the puzle
at a corresponding point on the opposite side.

In some scenarios your cursor actually becomes
one of the pieces of the puzzle. In this case you
must activate the puzzle by moving your mouse
cursor onto the puzzle area and then clicking the
mouse button or pressing the spacebar on the key-

hoard.

You always hear a mus ical tone when you master
an Hlusion (when the Sounds option under the
Options Menu 15 on).

Don’r hesitate o rry anything to master the
scenario. If you get stuck you can restart the

puzzle ar any time,

The Twelve Hlusions
The following section gives you rules and hints

for each of the 12 rypes of Hlusions.

Figure Ground

The screen displays two grids (labeled Puzzle and
Gaoal) filled with different colored squares (black &
white versions have black, white, gray and various

patterns). The object is to rearrange squares or groups

“"an'ling.: W hen sou're l:'lf SUUHATCS i th.‘ I.:llI.ZZIf-.! Efld (R IT.I.i'lt(.'h thL‘ '['I-'ifl"f'fﬁ in

clearing the records fur one the Gaoal grid.
player, all the reconds for . ¥

To move a square or group of squares in the
ench usion oype are E

cleared. You canawor clear Puzzle, use the mouse to click and drag a piece to a

only one type of THusion. NEW PosIFion.




Selecting a square causes that square and all other
squares of the same color or pattern connecred o it
by edpes (not corners) to be lifted off the plane as a
single unit. The squares revealed undemneath will be
of a different color or partern than the moved piece.

In scenarios with more than two colors or part-
temns, they uncover cach other in a eyclical order,
Once a piece has been drageed into overlapping or
edge-to-edge contact with another piece of the same
color or partern, the two pieces fuse permanently into
One prece.

Undo: Although there are no keyboard conrrols
used in Figure Ground puzzles the Undo option is
available. Selecting Undo from the Edit Menu or

pressing @6 Z undoes vour last move,

Levels

Ocean — “Whire Cenrer” The board has squares
of two types {white and another shade), but only the
non-white squares can be moved. When a non-white
piece is moved, it uncovers white squares. (Note: In
rwo scenarios, a third rype is added, which also
uncovers white squares when moved. )

Desert — “Three Colors™ The board has squares
of three different colors or parterns. A specific color
or pattern always uncovers another specific color or
partern. For example, if the three colors are black,
white and gray, black always uncovers white, whirte
always uncovers gray, and gray always uncovers black.

Mountain — “Four Colors™ The board has squares
of tour different colors or parterns. As in the Desert
level, a specific color or pattern always uncovers
another specific color or pattern. (Note: In the tinal
scenario, the rules change slightly - two of the colors

uncover one ather color, For example, two of the




colors or patterns will only uncover black while the

other two colors or patterns will only uncover white. )
Sky — “Two Colors™ The board has squares of

anly two different colors or patterns as in the Ocean

level, but now both colors can be moved.

Cursor Warping

The object is to deactivare targets by hitting
them with the cursor. When an appropriate target is
deactivated, it rums gray. Targets must be deactivared
in a specific order for each puzzle.,

Your goal is to deactivare all targets of the same
color in a given scenario before you can hit rargees of
the next color. {Black & white versions will have
numbered targets.)

Example: You have deactivared all but one of the
first type of target and then the cursor touches another
rype. Whart happens! All of the first rype of targets
reacrivare.

Clicking the mouse button on the puzzle or press-
ing the spacebar activates the puzzle cursor, You may
chose 1o acrivate the cursor in a specific part of the
puzzle. In some levels, however, you cannot start in
certain areas. If the cursor flashes or you can’t move
it, that means you tried to start in an imvalid location,

Note: During play, pressing the spacebar returns
vour normal cursor and causes the scenario w restart.
This prevents you from being able to “place” your
cursor a second time.

Some scenarios have a wrap-around feature iden-
tified by a shaded border around the puzle.

There are no keyboard controls used and no

Undo option available in Cursor Warping puzzles,




Levels

Ocean — “Velocity” Moving the mouse affects
the velocity of the cursor as well as the position. If
vou do nothing, the cursor continues traveling in the
same dircction, bouncing off the edges of the screen.

Desert — “Symmetries” The cursor velocity
funcrions the same as in the Ocean level, bur the
cursor now moves in unusual response to the mouse
movement. Sometimes the cursor moves opposite to
the mouse; sometimes at a 90-degree angle; some-
rimes in a “mirror” relationship (up/down movement
15 the same whale left/nght movement is opposite, or
vice versa),

Mountain — “Walls & lce” Same as the Ocean
level but now you are challenged by solid walls and
by patches of “ice” where you have no control over
the cursor.

Sky — “Slopes & Troughs” Same as the Ocean
level but now slopes and troughs affect cursor move-
MEnt.

Slope is indicared by shaded areas. The cursor
gains momentum in the direction of the darkest
shading.

Troughs are the least shaded arcas that the cursor

tHlows towards as a result of following the slopes.

Sliding Graphics
You're given a collection of blocks that slide
around within a playing field. Blocks cannor overlap

one another or cross beyond the boundary of the play-

ing ficld. The object is to rearranee the blocks to

martch the configuration in the goal square w the right.
Some goal boxes only show some of the pieces

available in the puzzle box. In this case, you only




need o get those pieces to match the key goal posi-
rions; the other piece positions are irrelevant.
MNote that you can push pieces with other pieces.
There are no keyboard controls used and no

Undo option available in Sliding Graphics puzzles.

Levels

Ocean — “Single-Square Pieces” All pieces are
single squares. Some squares may be frozen and can-
not be moved. Some pieces may have rwo colors or
patterns,

Desert — “Rectangular Pieces” Same as the
Okcean level, except some pieces are larger than a sin-
gle square.

Mountain - “"Concave Pieces” Pieces appear ina
variety of shapes like squares, rectangles, L's and
crosses. Some pieces are frozen and cannot be moved.
Some pieces may have two colors or parterns.

Sky — “Disconnected Picces” Some pieces appear
to be disconnected; however, if vou move one part of

such a piece, the other part moves as well.

Multiple Cursors

The playing field consists of groups of cells which

contain SLIURTES, AT CLICOS lil'l'ij-. O SO ll—""i-"E'IF-:.

circles or stars. The goal is to use the cursors to pick

up squares and move them into particular positions.

Clicking the mouse button anywhere on the
puzzle or pressing the spacebar activates the puzzle
cursors. Mow, whenever §iHa click the mouse button,
the puzzle cursors will pick up or drop any square they
are touching,

You control the entire array of cursors, but differ-

ent cursors may move in different symmetrical

"



relationships to the mouse movements. For instance,
when the mouse moves left and up, some of the
cursors may match that movement, but others may
move right and down, while still others may move
right and up!

There is another challenge as well. Each cursor
can move only within its rectangular cell. In order to
move a square from cell to cell, you have ro place rhe
square over the edee of one cell into the next, where
the neighboring cell’s cursor can reach it

Important: Clicking the mouse button can result
in dropping one square with one cursor while simulta-
neously picking up another square with a different
cursor. Picking up a square with more than one cursor
also has interesting and usetul resules,

There are no kevboard controls used and no
Undo option available in Multiple Cursors puzzles.

Pressing the spacebar pauses the game and returns

Wiour normal mouse cursor.

Levels

Ocean - “Unity” Your goal 1s to unite squares by
moving them with the cursors unril they touch each
other.

Desert —“Match” Same as the Ocean level
except you now have more than one type of square
and you must unite squares of only the same type.

Mountain — “Touch Base” Move squares until

they touch the circular goals. In scenarios with mulri-

ple goals, each poal must be used ar least once.
Sky - “Multi-Color” Same as the Mountain level

but now there is more than one type of square and
poal. Squares must touch only goals of the same rype.
In scenarios with multiple poals of the same type,

cach goal must be used at least once.
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Identity Maze

The playing field is a maze in which one or more
CUrsOr squares move in various symmetrical relation-
ships. For instance, controlling two cursors in a maze
may result in the cursors moving in opposite direc-
rions. The goal is to guide your cursor squares 1o one
or more circular goals.

Clicking the mouse burton or pressing the space-
bar activates the cursor square(s).

Whenever either of the cursors runs into an
obstacle, both are blocked. Cursors may not need to
capture goals ar the same time.

If there is more than one cursor in a scenario, at
least one will match the movements of the mouse or
keyboard. All the cursors are linked and will move
together but not all cursors will move in the same
direction as the one controlled by the mouse or key-
hoard.

Some scenarios have a wrap-around feature

identified by a shaded border around the puzzle.

Kevboard Control

When the cursor squares are activated, they can
be controlled by the mouse, by the arrow keys or by
selecred keyboard kevs identified in rhe Keys option
under the Option menu. You can change the key
selection by highlighting within each directional box
and typing the key you wish to use. (Note: Not all
keyhoard keys are assignable.)

Pressing the spacebar pauses the game and returns
your normal mouse cursor.

The Undo option is not available in ldentity

Maze puzzles. .
3 My iy




Levels

Ocean - “Paralle]” Cursors move in the same
direction as the mouse or directional keys on the key-
board.

Desert - “1580 Rotation” Mulriple cursors move
in opposite directions. For example, if you have two
cursors, moving the mouse up and left {(or pressing
the up arrow key and then the left arrow key) causes
one cursor to move up and left and the other cursor
to move down and right.

Mountain - “Mirror” Groups of cursors move as
if mirroring others in an imaginary verrical mirror.
Think of twin cursors paired on either side of a
mirror. Move one up and the other moves up, but
move one left and the orther moves right.

Sky - “90 Rotation” Two cursors move in a
perpendicular relarionship; it one cursor moves right

and then up, the other moves up, then lefr.

Changing Bodies

Yo 1_'1.F1'I.ITUE ONe OF IMOore activie CUrsor squares as

vou wander through a maze of impassable walls and
frozen cursor squares on your way to the circular
goals. Active cursors can, in effect, “pass through”
frozen cursors. When this happens, the active cursor
square becomes a wall while the frozen cursor
unfreczes and becomes an acrive cursor and moves
along with any orher active cursor. Control 1s trans-
ferred from one cursor to another in this manner, like
a “migration of souls.”

Clicking the mouse button or pressing the space-
bar activates the cursor square(s). The cursor(s) can
travel only horizoneally or vertically. The direction

vou approach a frozen cursor from is very important.




Since you create new walls by unfreezing cursors, be

careful not to block yourself in.

Some scenarios have a wrap-around feature iden-
tified by a shaded border around the puzzle,
The Undo option is not available in Changing

Bodies puzzles.

Kevboard Control

When the cursor squares are activated, they can
be controlled by the mouse, by the arrow keys or by
selected keyboard keys identified in the Keys option
under the Option menu. You can change the key
selection by highlighting within each directional box
and typing the key you wish to use. (Nore: Not all
kevboard keys are assignable.)

Pressing the spacebar pauses the game and retumns

our n-:}rmul ITLCASL CLUTSOT.

Levels

Ocean - “Standard” The active cursor is a single
square that unfreezes frozen cursors thar then become
walls. The object is 1o reach the circular goal(s).

Desert — “Frozen Goal” Same as the Ocean level
but now the goal is frozen. You must unfreeze all
frozen cursors o unfreeze the goal.

Mountain - “ Aggregate Cursor” You contral two
cursor sqquares. Coals may be normal or frozen,

Sky — “Free Partner” Normally, if one of your
twi cursors is blocked by a wall, the other cursor
stops. In Sky, if one active cursor is adjacent to a
frozen cursor, it can unfreeze that cursor even if the
other cursor is blocked, but its relationship to the

other cursor will change.,




(Gaining Losing

You control a fleer of active cursor squares navi-
gating a field filled with frozen cursor squares and
holes. Whenever an active cursor touches a frozen
cursor, the frozen cursor unfreezes and is added o
your fleet of active cursors. Whenever any of your
cursors drops into a hole, the cursor is lost. Your
cursor may sometimes consist of disconnecred parts
thar move in unison.

The object is to move your fleet of cursors onto a
goal of marked squares. The configuration of your
cursor fleet must exactly match the goal contiguration.

Clicking the mouse burton or pressing the space-
bar activates the cursor square(s).

Cursors can move horizontally or vertically, but
impassable walls thar can block cursor movement
appear throughout all levels. If any cursor in the fleet
hits a wall, the entire fleet halts. Since slow, precise
movement is sometimes important in Gaining
Losing, it might be easier to use the kevboard
directional keys rather than the mouse.

Some scenarios have a wrap-around fearure
identified by a shaded border around the puzzle.

The Undo option is not available in Gaining

Losing puzzles.

Kevboard Control

When the cursor squares are activated, they can
be controlled by the mouse, by the arrow keys or by
selected kevboard keys identified in the Keys option
under the Option menu. You can change the key
selection by highlighting within cach directional box
andd typing the key vou wish to use. (Note: Not all
keyboard keys are assignable.)

Pressing the spacebar pauses the game and returns

Vour T'II-."I'I'I'IL:tI ITROLESE LIPSO,
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Levels

Ocean — “Losing Only” There are holes, but no
frozen cursors. The object is to move through the
maze, losing cursors until the fleet of cursors exactly
matches the pattern of goal squares.

Desert — “Gaining Only” There are many trozen
cursors. The goal is to unfreeze and gain cursor
squares until your fleet is the same as the pattern of
the poal squares.

Mountain — “Gaining/Losing” Combines the
rules from the Ocean and Desert levels, with both
holes and trozen cursors.

Sky - “Wraparound” Same rules as the
Mountain level but adds the ability to wrap the cur-

sor(s) around to the opposite side of the puzzle.

Antimaze
The cursor is a single square that you need to
navigate through what appears to be an ordinary

maze of walls, But as you navigate the maze, it

behaves in a surprising way. What appears to be a

solid wall is actually a passable area and whar appears

to be an opening is actually impassable!

Clicking the mouse button or pressing the space-
bar activates the cursor square(s).

Some scenarios have a wrap-around feature iden-
tified by a shaded border around the puzzle.

The Undo option is not available in Antimaze

puzzles.

Kevboard Control
When the cursor square is activared, it can be
comirolled by the mouse, by the ammow keys or by

selected kevboard keys identified in the Keys option




under the Option menu. You can change the key
selection by highlighting within each directional box
and typing the key vou wish to use. (Note: Not all
keyboard keys are assignable. )

Pressing the spacebar pauses the game and returns

WO ['IUl'l.Ili:EI ITROWESE CLINSOE.

Levels

Ocean — "Antimaze” You set out after a single
eoal. Walled areas allow passage, open areas do not.

Deesert — “Multiple Goals™ Same as the Ocean
level, but with more than one goal.

Mountain - “No Return” Combines the Ocean
and Desert levels, but adds wraparound screens and
one-time walls — thinner, light-colored walls thar dis-
appear once you cross them,

Sky — “Flip-Flop™ Rules from all previous levels
apply, but the multiple goals trigger another phenom-
enon — each time you collect a goal, the puzzle flip-
tlops, changing from antimaze to standard maze, or

VICE VETSA.

Flip Turn

The goal is to stack and flip transparent sheets

with squares “painted” on them, until their composire
(the pattern of squares they make when stacked)
matches the design pictured in the Goal at the far
right of the screen.

The individual sheets (in groups of four or six) are
pictured at the left. Their Composite sheet — whar they
currently look like stacked - is next to the Goal sheet.

To flip or tum an individual sheet, select the sheer
and then select an arrow icon {ar the far left) to tum

the sheet left 90-degrees, right 90-degree, or to flip it




vertically or horizontally. Whichever sheer you select
“pops” to the top of the stack on the composite square.

A border around a sheet indicates that it is cur-
rently active. The width of the border indicares its
placement in the composite stack; the narrower the
border, the farther down in the stack it is.

In advanced levels you must select the correct
sheets to be stacked from several available sheets.

There are no keyboard controls used and no

Undo option available in Flip Turn puzzles.

Levels

Ocean - “Single Colors™ There are four sheets of
squares. Each square on any sheet is a single color or
partern.

Desert — “Diagonal Split” Same as the Ocean
level, except some of the individual squares on a
sheet are split diagonally into rwo colors or patterns.

Mountain — “Six Sheets” Now vou're stacking six
sheets of squares. Squares can be one or two colors or

parterns.
Sky — “Four of Six" Six sheets are available, but

you can only use from two to five of the sheets to

stack in the composite. Squares can be one or two

colors or patrerns.

Regrouping

The playing field is a configuration of lines drawn
on a grid. Selecting certain places on the lines picks
up some configuration of lines surrounding the cursor.
You can then move the configuration to another
position on the grid and drop it The object is wo
match the goal configuration in shape and position

within the Goal box.




Undo: Although there are no keyboard conerols
used in Regrouping puzzles, the Undo option is avail-
able. Selecting Undo from the Edit Menu or pressing
3 7 undoes vour last move.

Tip: It you have trouble pickinfz up a square, Ly

selecting it from different corners.

Levels

Ocean - “Lines” Drag sets of connected lines to
overlap or touch other lines until they march the goal
figure, When you drop a set on top of another set or
connect them at the edges, they permanently merge
or fuse into a smgle unir.

Desert — "1 x 1 Squares” Only the squares are
movable, Arrange the squares to match the goal fig-
ure. To pick up a square, click anywhere inside the
SCJLLATE.

Mountain — “Biggest Square” Clicking in any
corner picks up the biggest possible square going our
from that corner.

Sky - “L's" When you click at the intersection of
any two lines, you pick up the biggest possible L-
shaped piece going out from that comer. The hori-
zontal and vertical lines of the “L” need not be the

same length.

Fit Fall
At its simplest level, this is a straightforward jig-

saw puzzle, fitting pieces into a well. Pieces are made

up of squares arranged into various shapes. Select a

picce to pick it up, drag it to where you want to place
it in the well and then drop it. Well size will vary in
depth, width and lengrth.

Dropping a piece over the well causes each square

L
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within the piece to fall to the lowest level it can. Thus,
if the ground a picce falls on is uneven, the individual
squares of the piece separate to match the termin. The
aoal is to fill the well exactly to ground level.

Pieces dropped into the well can be pulled out as
long as there is no other piece completely hiding it
from view, If you pull out a piece, the remaining
picces will fall to the lowest possible level,

In some scenarios there are arrow icons ar the far
left that vou can use to rurn pieces 90-degrees right or
left or flip them horizontally or vertically. To flip or
turn a piece, select that piece and then select the
ATTOW ICON.

The configurations are not always as they first
seemy; some large pieces will break down into smaller
ONEs.

There are no keyboard controls used and no

Undo option available in Fit Fall puzzles.

Levels

Ocean - “One Level Deep” Fill a well that is one
layer deep.

Desert — “Multiple Deprhs™ Fill a well that is
two orf more layers deep.

Mountain - “Infinite Pieces” One type of picce
may be single use (pieces that can only be used once).
Orther types of pieces are infinite (they leave copies of
themselves behind, providing an unlimited supply.)
Some puzzles only have intinite pieces.

Sky — “Disconnected Pieces” Like the Mountain
level, there may be single use and infinite use pieces
but some picces will be disconnecred. Some puzzles

only have one rype of piece.




Convex Concave

This is a rrue set of oprical illusions. The object is
to construct the goal configuration from a number of
pleces.

Move the cursor onto a picce and then click and
drag it to where you want to place it. With overlap-
ping pieces, the piece most recently placed moves ro
the top. There is a snap-to-grid feature for easier
placement - pieces placed slightly out of line will
snap into alignment. The exact structure of pieces is
not always clear. Some large configurations will break
down into smaller pieces.

When you combine pieces, they do not merge. If
you want to deconstruct a figure, click and drag
pieces out of the figure one at a time. You cannot flip
ot turn pieces in this [Husion.

There are no keyboard controls used and no
Undo option available in Convex Concave puzzles,

Tip: It helps to build figures from back o front.

You can build on top of the goal configuration.

Levels

Ocean - “2D" Shapes are hasically two-dimen-
sional arrangements.

Desert — “300" Shapes appear to be three-dimen-
sional, but remember to think in two dimensions.

Mountain — “Convex/Concave™ these oprical
illusions are inspired by Escher's famous “Convex and

Concave” lithograph. A question you are sure to ask

yourself: “Is it sticking out or sticking in? The

answer is “neither.”

Sky — “Up/Down” These optical illusions are
inspired by the Penrose Triangle featured in Escher's
lithograph “Waterfall,” in which water tumbles over a
cascade, drops down a series of aqueducrs, only to end
up at the top of the falls again!




Shambhala is about the path of

warriovship, or the path of bravery,

that is open to any human being
who seeks a genuine and fearless
existence. Warmorship is a
continual journey. When the

warrior has unwaverg discipline,
he takes joy in the jowney.. .every
step of the way.

From Shambhala: The Sacred
Path of the Warrior




The Pilgrimage is designed to be the culminating

experience of Heaven & Earth.

A Pilerimage is a randomly ordered series of 108
steps that must be taken in the order presented to
you, one at a time. The steps consist of brand new
Hlusion and Pendulum scenarios, single hands of the
Card Game, and a number of inspirational poems
known as Tantras.

Each aspect of Heaven & Earth is an entertain-

ment = whether the Card Game, the [llusions or the
Pendulum. But they are also practices — mental prac-
tices thar require understanding, insight, discipling
and perseverance to master.

Your progress in a Pilgrimage is represented by
the number of squares filled in on the Pilgrimage
Shambhala screen. There is one square filled for each

of the 108 steps of the Pilgrimage.

How to Embark on a Pilgrimage

To embark on a Pilgrimage, you need not have

mastered all three aspects, but you will be berter
prepared for what you will encounter on a Pilgrimage
if you have experience.

Select the Palace near the center of the Gateway
screen and the Pilgrimage Shambhala screen appears
and a Welcome Pilgrim window,

Each time a player embarks on or returns to a

Pilgrimage, the Welcome window will display the

tollowing options:

Gateway

Selecting Gateway returns you to the Gateway
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Plavyers
Selecting Players opens a Plaver's oprion window

with the following options:

New

(Opens a Name the Player window with the word
“Player” highlighted. You can name a new player
by typing the name and then selecring Save or
pressing the Beturn key.

Open

Opens a window listing saved games (if any).
You can open a saved game by double-clicking on
the name or selecting it and then selecting Open

ot pressing the Rerum key.

Cancel
Closes the Player's option window and returns

vou to the Welcome window.

Continue

Selecring Continue starts you on your journey,
If you are a returning Pilgrim, the Welcome window
will also indicate your progress after your name,
Selecting Continue will then take you to your next

uncompleted step.

Note: You cannot |._'|:'|;|1'|1,_1£= a [‘ILTIr'l:‘I"S name while
on a Pilgrimage. If you wish to change players, you

must return to the Gateway screen and re-select the

Pilgrimage palace icon and change names when the

Welcome window appears. A new player will begin
on the first step of a new Pilgrimage. Opening a
saved game will display the progress of that player and

continue on to that player's next uncomplered step.
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Command Keys
The tollowing command keys can be used within
the Pilgrimage:

a6 G Returns vou to the main Gareway screen
# Q Returns vou ro the deskrop
38 R Restarts the current scenario

3 Z  Undoes previous move (where available)

Pilgrimage Menu Bars

Within the Pilgrimage scenarios, clicking on the
top of the screen displays a Menu bar with the tollow-
ing options: ®, File, Edit, Options and Pilgrimage.

#, File, Edit and Options Menus
The options available will be the same as they are
tor the individual Pendulum, Card Game and [usion

SCCTVATIOS.,

Pilerimage
Selecring Pilgrimage displays the following

options:

Restart 3R

Restarts the current Pilgrimage scenario.

Help
Opens a window with information about the

Heaven & Earth Pilerimage.

The Steps of a Pilgrimage

The 108 steps occur in a random order each time

a difterent pilgrim embarks on a Pilgrimage; thus,
every pilgrim takes a different path. Steps within any

given Pilgrimage must be taken one ar a rime, and in
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the order they appear. You cannot bypass a step — you
must complete the current step before you can move
on to the next one.

After you solve each step, a section of the
Shambhala screen is enhanced and a window appears
indicating the steps you have completed and the fol-

lowing options:

Crateway

Returns you to the Gateway screen.

View
(lears the '..l.-'mdq_m' SO0 YO0 CAn ook at the screen

without obstructions.

Continue

Takes you 1o the next step in the Pilgrimage.

When you have completed the 108th - and final
— step of your Pilgrimage, vou will see your visual

reward in its entirety.

Each step begins with a message and the steps will

be one of the following four types:

Heaven & Earth Cards (Total of 30 steps).
The Pilgrimage version features a single 12-card
hand rather than the full four-hand game. The goal
is 1o creare tricks that eam the highest possible point
rotal. The goal score that must be achieved is dis-

played in the Info Bar.

The Musions (Total of 48 steps). The Hlusions
scenarios that you encounter in a Pilgnmage repre-
sent cach of the 48 levels (12 types, 4 levels each)

that vou encountered in the Hlusions portion of
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Heaven & Earth. These are 48 new scenarios creared
especially for the Pilgrimage.

The Pendulum (Total of 12 steps). You will find
12 entirely new Pendulum scenarios to master in the
same manner as the Pendulum portion of Heaven &
Earth. Each scenario takes place in a Heaven & Earth

bowl created especially for the Pilgrimage.

The Tantra (Total of 18 steps). The Tantra are
poems of inspirational grace and wisdom. A Tantra is
for you to enjoy; it does not require mastering. After
you read a Tantra, click the mouse button to go to
the Shambhala screen. Reading the Tantra is regard-

ed as completing a step in the Pilgrimage.

The Cards, Hlusions, Pendulum and Tantra
appear in an order created especially for your
Pilgrimage. You might starr with several Card hands,
solve two Hlusions, complete a Pendulum and then
receive a Tantra. Another pill::rirn might start with
one [usion, solve a Pendulum, receive a Tantra and
then play three Card hands — the order of the
Pilgrimage steps is complerely unigue to the pilgrim.

Take your time on the Pilgrimage. If you've start-
ed a Pilerimage, you are not required to stay on it.
You can return to the main part of Heaven & Earth

and continue to work on any Hlusion, Pendulum or

Card Game you may not have mastered. You can

then pick up where you left off on your Pilgrimage
whenever you feel comfortable with vour skills and

understanding.




Finishing a Pilgrimage
After you have successtully complered a
Pilgrimage (all 108 steps), vou should leave your cur-

rent player file by selecting Players from the File

menu or on the Welcome Player Pilgimage screen.
Select New and enter a new name to establish a new
plaver file.

Each player file holds a limited amount of infor-
mation. As you complete each step of the Pilgrimage,
the file grows in size, When you have completed a
Pilgrimage, for optimal performance close the current

plaver tile and start a new one.




Appendix A: Troubleshooting Guide

Problem: The program doesn’t install properly.

B Do you have the necessary equipment as listed under “Equipment

Requirements”!

B s each component of your computer system (compurer, moniror, hard drive,

ete.) plugged in securely? Turned on?
W Did you follow the installation process step by step!?
W Did you select the installation format appropriate to your system hardware?

B [Does your system have the necessary RAM as listed under “Equipment
Fequirements™! If you have less than 574K of free RAM, the installer program

will Five you the ITICSSA: “There is not L‘t'h.:ll.lj-_‘:h RAM to run the installer.”

Does your hard drive have enough space available to complere the installa-
tion! If you have less than the required amount of space on your hard drive,
the installer program will give vou the message: “There is not enough space

available on this volume 1o install the files.”

Are the floppy disks damaged? I a disk is damaged you will get the message:
“The FILE (tiles) cannot be installed.” It your disks are damaged please refer w
Appendix B: Buena Vista Software Customer Service, for information abour
replacement of damaged disks.

Did you open andfor alter anything in the installer control files? 1f the
installer file is damaged vou will get the message: “The installer files are dam-
aged.” Please refer o Appendix B: Buena Vista Sottware Customer Service, tor

information about damaged disks.
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Problem: The program doesn't run properly.

B After the install process was complete, did you remove any files or folders from
the H&E Resources folder!

B Are vou running under the same system that was used ro install the program?

B Do you have any peripheral devices on your system (modems, scanners, CD-
ROM digitizers, ete.)? Did you change or add any peripherals after installing
the program? Some of these devices may be trying to use the same hardware
interrupts, keeping the program from loading. Try unhooking any unnecessary

peripherals, reboating the computer and re-installing the program.

B Did you carefully answer the copy protection question! If you answered the

Guestion 'annrrﬂ'ﬂ'f, Yol Are returned to the desktop.

Problem: I've checked all of the above and the program still
doesn’t install.

B If you are still having trouble installing Heaven & Earth, disable all INITs such

as screen savers and virus checkers, restart your Mac and re-install,
Problem: The mouse isn’t working as expected.

M Is the mouse plugged into your computer securely!

B Are you trying to use the mouse in ways not indicated under the Help secrion

of the program!?

Problem: The sound warbles, breaks up, or is missing.

B Docs your system have an accelerator board? (See the section on Accelerator

Boards under “Equipment Reguirements.”)

B |5 the Sounsd option turmed off under the Options Menu!? (Options that are

active (on) have a checkmark next o them. )

B |: the Sound setting on your Control Panel rurmed down!?




B s the “H&E Sounds” file in your “H&E Resources” folder!

Problem: Colors do not appear as expected.

B Are your monitor's contrast, color and tint controls properly adjusted!

B Are vour monitor cables securely attached!

B Is the Monitor color setting on your Control Panel properly set for your system!?

B Have you changed your monitor's color mode! The color versions of "Heaven

& Earth must run in the 256 Color mode.

Problem: The program runs slowly.

B [ncreasing the d}‘lrllin;_;u{'[un sz ],‘l}' an additional 500K ro 1000K of RAM will
result in improved performance of the program when moving berween the vari-
ous aspects of the game. To increase the application size, select the application
when ir is nor acrive, choose Get Info from the File Menu and then change the
application size when the window appears.

B If vou have a lower-end machine, you might try installing an accelerator board.

B If you are running under System 7, turning the virtual memory off will speed up

[].'ll..‘ eI,

Problem: The name of a saved game does not appear when
opened.

B s the name of the saved game more than 20 characrers! Try eliminating some

letrers from the name art the deskrop and re-opening the program.

Problem: 1 have to pass the copy protection every time I open the
program.

B Arc you opening the program from the Heaven & Earth application icon!
Some computers will trigger the copy protection when you open the applica-
tion from saved game icons. Try opening the game from the Heaven & Earth

icon and then selecting the saved game from within the program.




Problem: 1 get a multi-colored screen after closing a desk accessory.

B Are you running under system 6.x7 Are you running under MulriFinder! Do
you have the Hide in Background option under the Preferences option turned
off? If the answer is “ves™ to all these questions, then you will get a multi-col-
ored screen for 1 ro 3 seconds. This is caused by a memory limitation and does

now affect game play.

Questions and Answers
Here are answers to some of the questions you mighr ask:

(2: When | initially install Heaven & Earth, how many tiles are copies onto my
hard drive!

A: 9 files will be copied to your hard drive. (Installing more than one formar will
increase this number to 14 for two formats and 19 for three formars.)

(Q: Are there any files in the Heaven & Earth folder that [ can eliminate o save
room on my hard drive!

A: When you select the installer format, the installation program copies and
decompresses only those files necessary for the selected format. Removing any of
these files from the folder will effect the play of the game. The program is designed
to allow vou to keep only the files vou want to use. The files necessary for playing

the different aspects of “Heaven & Earth” are as follows:

The Pendulum  H&E**-Pendulum”

The Card Game H&E**-Card Game"”

The Musions H&E**-[llusions" and “"H&E Scenarios”
The Pilgrimage  All of the above files plus “H&E Pilgrimage”

Noate: Removing the Sounds file will save you approximately 700K and the pro-
gram will still be playable bur you will receive none of the sound “cues” that are

helpful, if nor essenrial, to the program.




(Q: Should there be a delay between the appearance of the opening screen and
the thunderclap!?

A Yes, berween 3 and 10 seconds.

(2: It takes a long time for some of the graphics in the program 1o come up. Why!
A: Heaven & Earth contains large amounts of graphics. Some machines may

require a few seconds to load all of the graphics for a scenario.

2 My disks are defecrive. Whar do 1 do!
A: Read Appendix B: Buena Vista Software Customer Service. You will find

informarion on our 90-day return policy. You may also consider returning to the

store where you purchased your disks for an exchange.

(Q: Some of the options under the Edit menu are always ghosted and unavailable.
Why!
A: The Edit Menu options on the Macintosh are a Macinrosh system standard.

Therefore, the unnecessary options were ghosted rather than removed.

(2: While playing Hlusion games, [ dragged a playing piece off the playing area
and lost it. How do | get it back!?

A: If a playing picce is dragped off the playing area you can usually retrieve it by
selecting the area it lies beneath and dragging it back. If the piece is under an icon
or other game information data, however, you will only be able to retrieve the

piece by choosing “Restart.”

(: While playing the Pendulum, my screen saver sometimes flashes. What should
| do!?

A: Some screen savers are activated by dragging the cursor to a comer of the
screen, If your screen saver is interrupting your game, disable your screen saver

while playing (or try changing the screen saver “rrigger” location ).

(2 How do | install more than one format on my hard drive!

A: If you want to install more than one format of Heaven & Earth, first create a
unique folder (e.g., H&E 12" Color, H&E 13" Color, or H&E B&W rather
than Heaven & Earth) for each format on your hard drive. Then repeat installa-

N g !
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tion steps 1 through 4 for each format, cach time selecring the unigque folder name

(during step 3) for the format you're installing.

(3 Heaven & Earth is opening in black and white when it should be in color. Why!
A If you installed more than one version of Heaven & Earth and one was the
black and white version, be sure 1o start Heaven & Earth by double-clicking on
the Heaven & Earth application icon for the color version. Do not start the pro-
gram by double-clicking on the saved game icon. When you launch Heaven &

Earth from a saved game icon, it might open in the black and white mode.

Appendix B: Buena Vista Software
Customer Service

Getting Help

Do you have a problem that you can't solve! Want to learn about future soft-
ware releases? Then contact our Customer Service staff. There are five ways o
contact us: calling, writing, faxing or using a modem to get on our Bulletin Board
System or CompuServe. If you are looking for solutions to “Heaven & Earth” sce-

narios, please refer to Appendix C: How To Ger Solutions.

Calling

You can call Buena Vista Software Customer Service ar (318) 562-1732,
Monday through Friday from 8:00 a.m. to 5:00 p.m. (Pacific Time). We'll be
happy to answer any questions you have.

If you have a technical problem that you need solved, please have the follow-

ing information ready before you call:

B The name of the program you are using.

B The type of computer you have.

B The system you are using.

B Whether you are running under MulriFinder.

B The type of hard drive and the memory available.




A derailed description of the problem you are having. The more information
you can give us on how the problem occurred, the faster we can find a solution. If
possible, please be ar your computer before you call. If we need to give you step-

by-step instructions, you can try them out as they are given.

Writing

We encourage you to write. It gives us a chance to answer your questions and
pass along any tips we may have about the program. We also welcome any com-
ments you might have about our product. If you are writing to us abour a rechnical

problem, please include all the information listed under “Calling.”

Buena Vista Software

Arm: Customer Service

500 South Buena Vista Street
Burbank, CA 91521-6385

Faxing

If you have access o a fax (facsimile machine), you can fax us messages at
(818) B46-0454. If you are faxing us about a technical problem, please include all
the information listed under “Calling.” Be sure o address the fax to “Customer

oervice.

Using Our Bulletin Board

If you own a modem and communication software, you can call the Buena
Vista Software BBS at (818) 567-4027. To use the board properly make sure your
communication parameters are set to 8, N, 1 (8 for 8 dara bits, N for no pariry and
| for 1 stop bit), terminal type is set for VYT107 and VT Mode is ANSIL. The
BBS supports modem speeds from 300 1o 9600 baud. The Buena Vista Software

BBS is a free 24-hour service for our customers. It provides private electronic mail

(e-mail) and public message areas, files for downloading to your compurer and

other surprises. Demos of our other titles and informarion on upcoming releases
are also available on the BBS.

CompuServe

We have on-line customer support in the Game Publishers Forum on




CompuServe. To access it, type GO GAMPUB at any "I" prompt. To read mes-
sages to and from Buena Vista Software, select the Messages menu choice and
then select the DISNEY/BUENA VISTA section. To download files, select the
Libraries menu choice and then choose the DISNEY/BUENA VISTA library.

If you're not a CompuServe member and would like ro be, you can call
CompuServe toll-free at 1-800-524-3388. Ask Representative #3621 for your free
introductory membership and $15 usage credit, Besides on-line support of Heaven
& Earth and our other Buena Vista Software products, CompuServe offers many
other services, including travel, reference, libraries, communications,

hardware/software support and more,

Disk Replacement
If your disks are defecrive and you need to return them for a replacement set,
please mail us only the disks (don't mail the packaging or other materials) with

your name, return address, and a description of the problem with the disks to:

Buena Vista Software
3333 N. Pagosa Court
Indianapolis, IN 46226

We'll replace vour disks at no charge within ninety (90) days after purchase,
provided you've mailed in your warranty card. It you didn't mail in your warranty
card, there is a replacement fee of $10.00. Please allow 3 1o 4 weeks for delivery.

When you send in the warranty card, you are entered into our customer files.
This lets us notify vou of product upgrades and future releases. It also helps us leam
more about you as a software consumer, which helps us develop products you can
enjoy.

Complete details on the limired warranty are as follows:

Limited Warranty

Buena Vista Software warrants to the original purchaser of this copy of the
compurter software program entitled HEAVEN & EARTH that the disks on
which this program is recorded will be free from defects in materials and workman-
ship for ninety days from the date of purchase. This warranty applies only to the

original purchaser who has filed a warranty card with Buena Vista Software.




The warranty is the only express warranty pertaining to this software program
and no other representations or claims of any nature shall be binding or obligate
Buena Vista Software. Any implied warranties of merchantability or fitness for a
particular purpose, if applicable, are limired o the ninety day period described
above. Buena Vista Software shall not be liable tor special,
tial, or other damages resulting from possession, use, or malfunction of this software
program. Some states do not allow limitarions on how long an implied warranty
lasts and/or rthe exclusion or limitation of incidental or consequential damages, so
the above limitations may not apply to you. This warranty gives you the specific

legal rights, and you may also have other rights which vary from state to state.

Apﬁendix C: How to Get Solutions

Because of the complexity and the tremendous number of puzzles in Heaven
& Earth, Buena Vista Software's Customer Service staff will be unable to provide
solutions to these puzzles.

The solutions ro all puzzles are available in a book called Heaven & Earth: The
Official Srategy Guide published by Prima Publishing. You can order this book
throuch the enclosed COMEPOT offer. It you can't find the Conpon, |‘I|E".=1F.E' call us ar

(H18) 562-1732.

HELP US FIGHT SOFTWARE PIRACY
PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE

The software yvou are using was produced through the efforts of many people:
designers, artists, programmers, distributors, retailers, and other dedicated profes-
siomals.

The cost of developing this and other software programs are recovered through
software sales. The unauthorized duplication of personal computer software raises
the cost to all legitimate users.

Buena Vista Sofrware, as a member of the Software Publishers Association
(SPA), supports the industry's effort to fight the illegal copying of personal com-
purer software. We appreciare your support. If you are aware of a copyright viola-

tlon, we urge Yo Bo contact:
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Software Publishers Association
1730 M Street, NW

Suite 700

Washingron, DC 20036

WARNING: It is a federal crime to make unauthorized copies of this soft-
ware. The enclosed software package is protected by copyright. All rights are
reserved. Lawiul users of this program are permitted to make one backup copy of
this software for archival purposes only. Any other duplicarion of this software,
including copies offered through sale, loan, rental or gift is a violation of law and

subject to both criminal and civil penalties.

Heaven & Earth is a trademark of Publishing International

Heaven & Farth software © 1992 Publishing International

The quotes from Shambhala: The Sacred Path of the Warrior, by Chigyam
Trungpa, edited by Carolyn Rose Gimian, is a Bantam Book published by arrange-
ment with Shambhala Publications, Inc. in 1986. Copyright © 1984 Chdogyam
Trungpa.

A Software Resources International Production
© Software Resources Intermational

and Buena Vista Software

Published by Buena Vista Software

500 5. Buena Vista Street

Burbank, CA 91521-6385
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Designers: Michael Feinberg and Scorr Kim
with Brad Fregger, lan Gilman & Michael Sandige
Programmers: lan Gilman & Sofie McKenzie
Art: Mark Ferrari
Sounds: Richard Marrion
Executive Producer: ). David Koch
Original Concept: Michael Feinberg
Producer and Director: Brad Fregger
Associate Producer: Noah Dudley
Assistant Producers: David Etheredge & Nancy Berman
Markering Product Manager: Joe Adney
Documentation: Joy 5. Bowman
Fackaging Production Manager: Jeft Nuzzi
Package Design: Michael Feinberg
Marketing Coordinaror: Helen Fillman
Chiality Assurance Manager: Jon Doellstedh
Cuality Assurance Lead Tester: Jeff Moore
Beta Testers: Joy Bowman, Tim Chambers, Howard Divossin, Andy Crarrison,
Judy Graeper, John Hancock, Susie Hancock, Stewart Irel, Michael Thoresen

Special thanks to Dick Aldrich (Iusion Design), Jacob Feinberg (Pilgrimage

Scenarios), Tomoya Ikeda (Graphics), Brodie Lockard (Inspiration), Steve
Mariotti (Additional Code), Jeff Moore (Technical Assistance), Kim Dermit and
Ellen Ferro.

Gassho to Mr. Yoshihiro Satoh, Mr. Takashi Ochiai of Fujitsu, Ltd. and Mr.
Thomas Randolph of Lanpro - Arigato!
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